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ABSTRACT 
Power systems can and have been impacted by harmonics generated during geomagnetic 
disturbance (GMD) events. These harmonic currents are generated from the part-cycle saturation 
of power transformers caused by the flow of Geomagnetically Induced Currents (GIC) through 
grid-connected transformers. This report describes a harmonic assessment tool, GICharm, 
needed by the industry to perform an adequate assessment of GMD-related distortion impacts. 
This report provides the background, approach and features of the GICharm tool. 
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1  
INTRODUCTION 
During geomagnetic disturbances (GMDs), magnetic field variations drive low-frequency 
electric currents along transmission lines and through transformer windings to ground. These 
geomagnetically-induced currents (GIC) produce part-cycle saturation. Figure 1-1 shows a 
typical harmonic spectrum of the current in one phase of a three-phase transformer bank with 
GIC in each phase that is 10% of the peak of the transformer winding’s rated peak (or crest) 
current; i.e., 0.03 pu GIC. As can be seen in the figure, the current injections are over a range of 
harmonic frequencies, and include both even and odd orders.  

Part-cycle saturation of a transformer can have both direct impact on the transformer itself, and 
various impacts on the power system performance. For example, during the March 1989 
geomagnetic storm, the following reported incidents were attributed to harmonic distortion 
created by GIC-saturated transformers [1][2]: 

• Static var compensator (SVC) tripping. In fact, seven SVCs tripped in rapid succession 
resulting in system instability and total blackout of one Canadian system. Post-event analysis 
revealed that harmonic distortion was the direct cause of the SVC trips.  

• Widespread tripping of capacitor banks  
• Generator trips due to negative sequence or phase imbalance protection (including one major 

nuclear unit). 
• HVDC system trip and an HVDC filter trip 
• Transmission line tripping. 

 
Figure 1-1 
Harmonic components of a single-phase transformer with part-cycle saturation 
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It should be emphasized that only one wide-scale blackout has ever occurred in North America 
due to GMD, the 1989 Hydro Quebec event, which was initiated by the impact of harmonics [1]. 

As part of assessing the performance of power systems subjected to geomagnetic disturbances, it 
is necessary to model the GIC produced by different levels of geomagnetic activity. Assessments 
of bulk system operational security using only fundamental frequency analysis (e.g., load flow 
and dynamic stability) may underestimate the risks of severe GMD. A more complete assessment 
should consider the harmonic effects; particularly where they cause loss of reactive support, 
increase the reactive power demand, and increase the probability of faults and other abrupt 
disturbances that could trigger system instability and collapse.  

System harmonic performance evaluation for GMD events, however, is particularly challenging 
due to the following factors:  

• GIC-saturated transformers result in a large number of harmonic sources distributed 
throughout the transmission grid. 

• Current injections are significant over a range of harmonic frequencies, including both even 
and odd orders. 

• Harmonic voltage distortion interacts with the transformers to alter the magnitude and phase 
of the injected harmonic currents; i.e., saturated transformers do not behave as ideal 
harmonic current sources. 

• The harmonic source characteristics of three-phase transformers are complex, and the 
sequence components of the harmonics produced do not appear exclusively in the classic 
pattern due to phase imbalance. Positive- and negative-sequence components of three-phase 
transformer exciting currents include triplen harmonics, and non-triplen harmonics have 
zero-sequence components. 

• Propagation of the harmonics produced by GIC saturation is in both the ground mode (zero-
sequence), as well as the line modes (positive- and negative-sequence). 

EPRI has developed a tool that meets the above requirements. The background, approach and 
features of this tool (GICharm) are discussed in the proceeding chapters. 
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2  
APPROACH 
Overview 
The overall GIC harmonics approach is illustrated in the flow chart in Figure 2-1. The software 
is named GICharm and is based on the EPRI OpenDSS program with auxiliary programs for 
time-domain solution and for importing data from other sources. The main network model is first 
constructed in the OpenDSS program. The GIC values are either computed using the OpenDSS 
model or imported from any of a number of computer tools in the industry capable of computing 
the GIC values given the GMD electric field values. A basic power flow calculation at 
fundamental frequency is then made. This may also be imported from another computer 
program’s results. This initializes the process. 

 
Figure 2-1 
GICharm Software Approach. 

The voltage computed at each transformer is applied to time-domain models of the transformers 
that include saturable elements. The part-cycle saturated current is computed with time-domain 
analysis. The harmonic currents are computed from the time-domain waveform data and used to 
populate the injection currents for the frequency-domain harmonic load flow analysis in the 
OpenDSS program. The resulting distorted voltages are passed back to the time domain analysis 
for a refined estimate of the current distortion. This process is repeated until there is a suitable 
convergence of the harmonic components of the current. 
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Transformer Modeling 
To characterize the excitation currents drawn by GIC exposed transformers, GICharm uses the 
magnetic circuit models of Figure 2-2, for 3-leg core, 5-leg core, shell-form and banks of 3 
single-phase core transformers [3][4]. Detailed values of the model parameters depend on the 
user input to the tool. If a power-cycle is discretized in K time steps, the flux linkage at each time 
step for each source in these models is determined by the numerical integration of the voltage 
across the corresponding winding terminals, over the power cycle. GICharm reconstructs the 
time-domain voltages across transformers winding terminals from the voltage spectra obtained 
from the harmonics solution, and then numerically integrates it to get the flux linkage values 
over the discretized power-cycle.  

 
Figure 2-2 
Core-topologies and magnetic circuit models in GICharm v1.0 
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As shown in Figure 2-2, the magnetic behavior of the transformer core is modeled by a set of 
reluctances and flux linkage sources connected to form a magnetic circuit. For the terminology 
of this section, it is important to remember that in magnetic circuits, reluctance is analog to 
resistance in electric circuits, while current (magnetomotive force over ampere-turns) is analog 
to voltage, and flux linkage is to current. This justifies the use of terms like “node current” or 
current “across” a reluctance.  

In an ideal scenario, the flux paths on the core topology have linear reluctance and the magnetic 
circuit can be described by a linear expression in nodal “permeance” form (analog to nodal 
admittance form), 

𝜆𝜆 = P 𝑖𝑖 Eq. 2-1 

where λ is a vector of flux linkages inputs, P is the permeance matrix of the magnetic circuit, and 
i is a vector of “node currents”. Node currents can be found by taking the inverse of P and 
solving (Eq. 2-1) for i. However, since the flux paths in a transformer core saturate under certain 
conditions, (Eq. 2-1) cannot accurately represent the core behavior without some additional 
considerations.  

 
Figure 2-3 
Piece-wise linear representation of saturable reluctances 

A flux path with saturable reluctance can be modeled as a piece-wise linear function like the one 
shown in Figure 2-3. The saturable element is then represented by a linear reluctance element 𝑅𝑅 
in parallel with a flux linkage source 𝜆𝜆0. These parameters are functions of the current value 𝑖𝑖 
“across” the reluctance. If the flux linkage 𝜆̂𝜆 is known, it is possible to iteratively find the 
corresponding current value 𝚤𝚤̂ “across” the saturable reluctance. First, it is assumed to be 
unsaturated and ℛ = ℛ𝑤𝑤  and 𝜆𝜆0 = 0. Thus, 𝑖𝑖1 = ℛ𝑤𝑤𝜆̂𝜆, where the sub-index 1 stands for the first 
iteration. The new current value is then used to update the slope of the curve and the flux linkage 
offset to ℛ = ℛ𝑥𝑥  and 𝜆𝜆0 = 𝜆𝜆𝑥𝑥. The new current value is then 𝑖𝑖2 = ℛ𝑥𝑥(𝜆̂𝜆 − 𝜆𝜆𝑥𝑥). This current 
value can be used to update the slope and offset parameters again, leading to 𝑖𝑖3 = ℛ𝑦𝑦(𝜆̂𝜆 − 𝜆𝜆𝑦𝑦). 
Since the new current value doesn’t produce an update, the routine stops and 𝚤𝚤̂ = 𝑖𝑖3 = ℛ𝑦𝑦(𝜆̂𝜆 −
𝜆𝜆𝑦𝑦). 
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The previous case is trivial, but it serves to illustrate the algorithm used by the GICharm tool to 
solve more complex magnetic circuits. To represent a non-linear magnetic circuit formed by flux 
linkage sources, linear reluctances, and piece-wise linear reluctance paths, let us consider, 

𝜆𝜆𝑘𝑘 = P𝑖𝑖 𝑘𝑘𝑖𝑖𝑘𝑘 + 𝜆𝜆𝑖𝑖 𝑘𝑘0 ,       𝑘𝑘 = {1,2, … ,𝐾𝐾} Eq. 2-2 

where 𝑘𝑘 is the sub-index for discrete time steps in a power cycle, and for time step 𝑘𝑘, 𝝀𝝀𝑘𝑘  is a 
vector of flux linkages, 𝐏𝐏𝒊𝒊 𝑘𝑘 is the permeance matrix of the magnetic circuit, 𝝀𝝀𝒊𝒊 𝑘𝑘0  is the vector of 
flux linkage offsets, and 𝒊𝒊𝑘𝑘 is a vector of “node currents”. Sub-index 𝒊𝒊 in matrices 𝐏𝐏𝒊𝒊 𝑘𝑘 and 
vectors 𝝀𝝀𝒊𝒊 𝑘𝑘0  is only used to highlight the dependence of their elements on the value of “node 
current” elements in 𝒊𝒊𝑘𝑘 at time step 𝑘𝑘. 

 
Figure 2-4 
Magnetic circuit solver algorithm flow chart 

Equation (2-2) can be solved for each time step using the magnetic circuit solver algorithm in 
Figure 2-4. This algorithm is based on the one proposed in [6] for solving monotone non-linear 
resistive networks. As it is shown in Figure 2-4, all saturable reluctances across the magnetic 
circuit are initially assumed to be unsaturated. The initial “node currents” are computed with this 
assumption. The saturable reluctances are then updated in subsequent iterations, resulting in 
updates to 𝐏𝐏𝒊𝒊 𝑘𝑘 and 𝝀𝝀𝒊𝒊 𝑘𝑘0 . In each iteration, a predictor 𝒊𝒊𝑘𝑘∗  is computed and the “node currents” 
vector 𝒊𝒊𝑘𝑘 are updated in the direction dictated by the error (𝒊𝒊𝑘𝑘∗ − 𝒊𝒊𝑘𝑘) and a positive factor 𝛾𝛾 ≤ 1. 
The stopping criterion is defined by the norm of the error reaching values below a tolerance 𝜀𝜀𝑠𝑠𝑠𝑠𝑠𝑠. 
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To solve for all the time steps simultaneously in each iteration, the implementation of the solver 
algorithm takes advantage of the linear algebra capabilities of the Python’s NumPy package [7], 
[8] (i.e., simultaneously finding the inverses of a packet of matrices 𝐏𝐏𝒊𝒊, as well as the 
simultaneous computation of the matrix products 𝐏𝐏𝒊𝒊−1(𝝀𝝀 − 𝝀𝝀𝒊𝒊0))  

The availability of the harmonic content of the flux linkage sources allows the use of the solver 
algorithm to find the “node currents” of the magnetic circuit. However, in the GIC scenario, 
additional parameters must be considered. In such cases, the harmonic content of the flux linkage 
sources is known, but the DC flux linkage is unknown. On the contrary, the DC components of 
currents “across” flux linkage sources are known, but their harmonic content is unknown. To 
solve this, the GICharm tool uses the DC flux finder algorithm proposed in Figure 2-5 before 
applying the magnetic circuit solver algorithm. 

The purpose of the proposed DC flux linkage finder algorithm is to find the DC flux linkage 
levels at the sources that result in the DC currents “across” their terminals (i.e., the GIC 
currents). The finder algorithm works with matrices 𝐏𝐏𝒊𝒊 𝑘𝑘−1 in (Eq. 2-2), after a few manipulations. 
To explain this, it is important to highlight that the DC components of the currents “across” 
terminals of flux linkage sources are known, but DC components of “node currents” are 
completely unknown. Therefore, the algorithm reduces 𝐏𝐏𝒊𝒊 𝑘𝑘−1 to a 𝑁𝑁 × 𝑁𝑁 matrix, 𝐀𝐀𝒊𝒊 𝑘𝑘 that 
considers only the 𝑁𝑁 flux linkage sources and 𝑁𝑁 the “currents across” their terminals. For that, it 
considers only rows and columns of 𝐏𝐏𝒊𝒊 𝑘𝑘−1 corresponding to nodes where flux linkage sources are 
directly connected, the rest is neglected. Then, row and column operations are applied to the 
remaining matrix until a 𝑁𝑁-dimensional matrix is reached. The row and column operations are 
dictated by the nodes where the sources are connected. For instance, if a source fixes a certain 
flux linkage value going from node 2 to node 4, row 2 is subtracted from row 4, and column 2 is 
subtracted from column 4 as well. The contribution of the flux linkage source to the currents 
“across” their terminals is given by, 

𝑖𝑖𝑘𝑘𝑠𝑠 = A𝑖𝑖 𝑘𝑘𝜆𝜆𝑘𝑘𝑠𝑠 ,       𝑘𝑘 = {1,2, … , K}, Eq. 2-3 

where 𝝀𝝀𝑘𝑘𝑠𝑠  is the 𝑁𝑁 × 1 vector of flux linkages sources at time step 𝑘𝑘, and 𝒊𝒊𝑘𝑘𝑠𝑠  is the 𝑁𝑁 × 1 vector 
of currents “across” the source terminals. The super-index 𝑠𝑠 is used here to differentiate from the 
expressions in (2-2). From (2-3), the DC currents “across” the source terminals can be found 
using, 

𝑖𝑖𝐷𝐷𝐷𝐷𝑠𝑠 = 1
𝐾𝐾

[I I ⋯ I] �

A𝑖𝑖 1
A𝑖𝑖 2
⋮

A𝑖𝑖 𝐾𝐾

� 𝜆𝜆𝐷𝐷𝐷𝐷𝑠𝑠 =  S 𝜆𝜆𝐷𝐷𝐷𝐷𝑠𝑠 , Eq. 2-4 
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Figure 2-5 
DC flux linkage finder algorithm flow chart 

where 𝝀𝝀𝐷𝐷𝐷𝐷𝑠𝑠  is the 𝑁𝑁 × 1 vector of DC components of the flux linkages sources, 𝒊𝒊𝐷𝐷𝐷𝐷𝑠𝑠  is the 
𝑁𝑁 × 1 vector of DC components of the currents “across” the source terminals, and the block 
matrix [𝐈𝐈 𝐈𝐈 ⋯ 𝐈𝐈] is built with 𝐾𝐾 identity 𝑁𝑁 ×𝑁𝑁 matrices. It should be noticed that 𝒊𝒊𝐷𝐷𝐷𝐷𝑠𝑠  and 
𝝀𝝀𝐷𝐷𝐷𝐷𝑠𝑠  don’t have a sub-index 𝑘𝑘 because they are common to all the time steps in the power cycle 
(since they are DC components). The product of block matrices in (Eq. 2-4) is replaced by the 𝐒𝐒 
matrix whose elements are the average of elements of matrices 𝐀𝐀𝒊𝒊 𝑘𝑘  over the time steps in a 
power cycle. From (Eq. 2-4), it is possible to notice that for 𝒊𝒊𝐷𝐷𝐷𝐷𝑠𝑠  to reach values equal to the GIC 
currents, the flux DC level would need to change by, 

 Δ𝜆𝜆𝐷𝐷𝐷𝐷𝑠𝑠 = S−1(𝑖𝑖𝐺𝐺𝐺𝐺𝐺𝐺𝑠𝑠 − 𝑖𝑖𝐷𝐷𝐷𝐷𝑠𝑠 ) Eq. 2-5 

Since saturable reluctances don’t have discontinuities in their piece-wise linear expressions, 
small changes in the flux linkage sources don’t result in drastic changes in matrices 𝐏𝐏𝒊𝒊 𝑘𝑘 and 
vectors 𝝀𝝀𝒊𝒊 𝑘𝑘0 . The DC flux finder algorithm takes advantage of this and uses (Eq. 2-5) to gradually 
increase the DC component of flux linkage sources until the DC component of currents “across” 
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the flux source terminal is equal to the GIC currents. At the same time, the algorithm 
progressively solves the magnetic circuit, and when the normalized magnitude of the error 
(𝒊𝒊𝐺𝐺𝐺𝐺𝐺𝐺𝑠𝑠 − 𝒊𝒊𝐷𝐷𝐷𝐷𝑠𝑠 ) goes below the tolerance 𝜀𝜀𝑓𝑓𝑓𝑓𝑓𝑓, the DC flux linkage finder stops and the magnetic 
circuit solver routine is run to get the final solution. 

The DC flux linkage finder algorithm produces time-domain waveforms for the excitation currents 
drawn by a GIC exposed transformer. These are post-processed to get the harmonic spectra, which 
are later used as inputs for the magnetizing branch representation of the transformer in the network 
model. The magnetizing branch of each transformer is defined by 3 separate load objects (one per 
phase) in OpenDSS, whose fundamental active and reactive power parameters are defined using 
the magnitudes and angles of the fundamental components of voltage across each winding, and of 
the excitation currents. Each load object is also assigned with a spectrum object that defines its 
response for harmonic orders higher than the fundamental. More details on the load object model 
of OpenDSS are provided in the next section. Finally, these loads are attached to a fictitious extra 
wye-connected winding created at the transformer object in the network model to solely host the 
magnetizing branch.  

System Modeling 

The OpenDSS program is perhaps better known as a power flow tool for simulating such things 
as solar PV profiles. However, it is a general frequency-domain nodal admittance solver and can 
perform a wide variety of analyses. In fact, the original application for the solver algorithm was 
harmonics analysis of arbitrary networks, and was later adapted for power flow analysis. 

The basic equation solved by the program is the familiar nodal admittance formulation, 

iinjection  =  YSYSTEM  v Eq. 2-6 

where 𝐯𝐯 is the vector of node voltages, 𝐢𝐢injection is the vector of injection currents at each node 
from non-linear elements, harmonic sources, etc., and 𝐘𝐘SYSTEM is the Nodal admittance matrix 
representing linear element admittances. 

The linear admittances in the circuit model are included in 𝐘𝐘SYSTEM  while nonlinear elements 
such as loads, generator, and transformer magnetizing impedances are modeled as Norton 
equivalents as shown in Figure 2-6. The linear admittances of the Norton equivalents are also 
included in the 𝐘𝐘SYSTEM matrix, while the current sources make up the components of the 
𝐢𝐢injection vector. 
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Figure 2-6 
Overall OpenDSS Circuit Model 

For power flow analysis, the injection currents typically represent the nonlinear voltage 
dependence of the loads and Eq. (2-6) is solved iteratively at fundamental frequency. For 
harmonics analysis, the injection currents represent the harmonic currents from the various nodes 
with distorted currents. After a fundamental frequency solution, OpenDSS executes a linear, 
non-iterative solution at each frequency present in the various harmonic sources in the problem. 

All load-class elements in OpenDSS have a harmonic spectrum associated with them. The detail 
of the model of an OpenDSS Load element for harmonics analysis is shown in Figure 2-7. The 
load model is used to represent transformer magnetizing currents in the GICharm analysis 
procedure. The injection current sources at harmonic frequencies are based on the fundamental 
frequency currents as indicated in Figure 2-7. In the Harmonic Load-Flow analysis, the 
magnetizing element of each transformer in the model is represented by an OpenDSS Load 
element with its fundamental frequency reactive power value set to the value determined from 
the time-domain simulation. 

The shunt admittances of the Load model can represent a specified mixture of series and parallel 
R-L branches. Each configuration has a different frequency response. These shunt branches can 
be neglected entirely (Set NeglectLoadY=Yes) so that the model consists solely of a current 
source. This is what is done in GICharm so that the harmonic currents computed in the time-
domain simulation are injected directly into the frequency-domain network for the harmonics 
solution. 

 

Injection (Compensation) Currents from Loads, Generators, etc.
(Power Conversion Elements)

VSOURCE

(Norton Equiv.)

Linear Part of Loads Included in YSYSTEM

YSYSTEM
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Figure 2-7 
Detail on Load Model for Harmonics Solution 
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3  
GETTING STARTED 
The main Graphical User Interface (GUI) for EPRI’s GICharm is shown in Figure 3-1. The 
workspace of the program consists of two independent analysis tools: System Level Analysis and 
Transformer Level Analysis. 

 
Figure 3-1  
Main workspace in GICharm: Transformer Level (top) and System Level Analysis (bottom) 
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The Transformer Level Analysis tool is intended to assess the response of different 3-phase 
transformer core topologies to various GIC inputs. In its current version, it can consider four core 
topologies: 3 single-phase core-form, 3-limb, 5-limb and Shell-form. Once the user selects a given 
core-topology, the tool automatically populates default parameter values that the user can modify 
to check their impact on the harmonics response. This tool offers two analysis options: 

1. Single GIC value analysis: This analysis allows the user to check the response of the chosen 
core-topology to a given GIC input in terms of excitation current waveforms and harmonic 
spectra per phase. The result of the analysis is in the form of waveforms whose values can be 
exported to *.csv files 

2. GIC sweep analysis: This analysis allows the user to define a range of GIC values and perform 
stepped simulations with a user selected step-size value. The results are in the form of 
excitation current waveforms per phase per GIC step, excitation current harmonic order 
magnitudes per phase against GIC value from the DC component up to the 8th harmonic order, 
and total reactive power loss against GIC values. The results of this analysis can also be 
exported to *.csv files. 

These two analysis options use the DC-flux finder algorithm of Figure 2-5. While solving the 
user-selected core topology for various GIC values in the GIC sweep analysis, the program takes 
advantage of the availability of multiple processor cores in the hosting machine to run several 
simulations simultaneously using parallel processing.  

The System Level Analysis tool on the other hand is developed to assess the impact of GIC 
related harmonics at the bulk system level. This tool works with OpenDSS models with 
characteristics that make it suitable for the proposed analysis. The program includes a converter 
from PSS/E to GICharm / OpenDSS that takes PSS/E *.raw and *.gic files as inputs and creates 
*.dss files to use with GICharm. The system level analysis tool works with the same transformer 
magnetic circuit core-topology models as the Transformer Level Analysis tool, allowing the 
system model to have transformers with any of the four core topologies mentioned before: 3 
single-phase core-form, 3-limb, 5-limb and Shell-form. The capabilities of the tool include: 

1. GIC flow analysis: GICharm uses the OpenDSS engine to run a quasi-DC (0.1Hz) analysis of 
the system under test. This analysis depends on a user-defined geomagnetic disturbance-
induced electric field, and on the geographic coordinates of the buses in the system. The GIC 
flows in this analysis, as well as the harmonic content of winding voltages determine the 
transformer’s core saturation, and therefore the excitation currents’ harmonic content and 
reactive power losses. A future revision of GICharm will include a tool to import the GIC flows 
directly from external sources. Presently GICs are computed with a defined uniform field in 
GICharm. 

2. Frequency Scan: To assess the impact of harmonics injected at a given bus in the system, this 
analysis tool allows the user to select an inject 1 Ampere at frequencies ranging from the 
fundamental to a user-defined higher harmonic order. As a result, the tool prompts the user 
with a figure of impedance magnitude against frequency. This frequency scan is useful to check 
for possible resonant frequencies in the system that might coincide with harmonic currents 
produced by transformer saturation. 
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3. Harmonic Loop Analysis: This is the primary function of the program, this analysis option 
allows the user to run a user-defined amount of iterations of the harmonics loop described in 
Figure 2-1. The iterations are cumulative, which means that each time the tool runs a user-
defined number of iterations, the system will be solved starting from the result of the previous 
iteration. The evolution of the system over all the cumulative iterations can be plotted for each 
of the GIC-affected transformers across the system. At each iteration of the harmonics loop, 
GICharm solves each of the transformer magnetic circuit models in the system for its own GIC 
level (obtained from the GIC flow analysis or imported from an external source). This task is 
performed using the DC-flux finder algorithm of Figure 2-5, taking advantage of the 
availability of multiple processor cores in the host machine to run simultaneous simulations 
using parallel processing. The higher the number of processor cores in the machine, the lower 
the solution time of the harmonics loop. 

4. Edit relevant system components: The OpenDSS models of some of the system components 
that are relevant to the GIC harmonics analysis can be edited through the GICharm user 
interface. The details that can be modified include the core-topology of transformers, and the 
connection status of capacitors and reactors. Other parameters can be directly modified using 
a text editor on the *.dss files containing the representation of each element.  

5. Evaluate the response of Transformers, Generators, Capacitors and Reactors: At each 
iteration of the harmonics loop, the program allows the user to check the excitation current 
waveforms and spectra for each GIC-affected transformer. The user can also check voltage 
waveforms and spectra at buses where transformers, generators, capacitors or reactors are 
connected. It is also possible to check waveforms and spectra of currents in the delta-connected 
windings of transformers, as well as the currents flowing through generators, capacitors or 
reactors. All these variables can be exported to *.csv files for external analysis. The exported 
results include the sequence components of each harmonic order. 

6. Geographic referenced circuit plots: GICharm includes a pane in its graphical user interface 
that allows the user to check variables like GIC flows, voltage total harmonic distortion 
(THDv), and fundamental voltage magnitudes over the geographic footprint of the system 
under test. The geographical circuit plot also allows the user to explore the system topology 
and locate circuit elements, access their analysis variables, or select a bus for a frequency scan 
analysis. 

7.  PSS/E to GICharm/OpenDSS converter: To allow users to import data from external industry 
software programs, GICharm includes a converter that takes *.raw and *.gic files from PSS/E 
as inputs, and creates two sets of *.dss files: one for work with OpenDSS and another one for 
work with GICharm. 

For a quick reference to the GICharm capabilities, the Help menu includes a submenu called 
Help documents which contains links to quick guides in PDF format. Additionally, some of the 
pop-up tool dialogs in GICharm have a “?” button at the top right corner which, once pressed, 
allow the user to hover the mouse cursor over the dialog window and click to get context 
information about editable fields or tables in the window itself.  

The following sections include step by step descriptions for each of the tools and capabilities 
described above. 
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4  
FEATURES AND EXAMPLES 
Transformer Level Analysis 
The Transformer Level Analysis tool uses the same magnetic circuit solver (Figure 2-4) and DC-
flux finder (Figure 2-5) algorithms as the System Level Analysis tool, but they work 
independently of each other. This means that the transformer level tool does not require a *.dss 
system model be loaded in GICharm to perform simulations. The tool interface is shown in 
Figure 4-1. To run transformer level simulations, a magnetic circuit model must be first created. 
To create this model, the user must select a core topology among the available options in the 
Transformer details frame and then click on the Create button. Available options include: 3 
single-phase, 5-limb, 3-limb and Shell-form. Selecting one of the available topologies results in 
the population of default values for transformer and core-topology parameters.  

 
Figure 4-1 
Defining transformer core-topology parameters 

Once a magnetic circuit model is created, the Create button gets disabled. If changes are made to 
the model parameters or the core topology is changed, then the Create button becomes enabled 
again.  

With a created magnetic circuit model, the user can run two types of analysis: A Single GIC 
value analysis, and a GIC sweep analysis. Figure 4-2 shows the results of the first of these 
analysis types. To run the single value analysis the user must define a GIC per phase value in 
per-unit of the rated peak current per phase for the transformer and click on the Run button. The 
results are waveform per phase figures and spectra per phase figures of the excitation currents.  
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Figure 4-2 
Running single GIC value analysis 

 
Figure 4-3 
Running GIC sweep analysis 

On the other hand, to run a GIC sweep analysis, the user must define the sweep range limits and 
the steps to divide the range as shown in Figure 4-3. The boundaries of the GIC sweep range are 
in per-unit of the rated peak current per phase of the transformer. The result of this simulation is 
made of figures of: reactive power losses versus GIC value, excitation current waveforms per 
phase for all the GIC values in the sweep range, and excitation current harmonic order 
magnitudes per phase versus GIC value (from DC up to the 8th harmonic order).  
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The data contained in the figures for both analysis types can be exported in the form of *.csv 
files as shown in Figure 4-4. 

 
Figure 4-4 
Exporting single GIC and GIC sweep analysis results 

System Level Analysis 
The following step by step guide is intended to help the user run a harmonics loop simulation in 
GICharm. Before starting, it is important to mention that the *.dss files used in the example of 
this section were converted from a set of *.raw and *.gic files obtained from [9]. From the file 
menu click on the Open button or directly click the Open button in the toolbar as shown in 
Figure 4-5. This will enable the Load OpenDSS circuit button. GICharm will scan the selected 
case and the user will be prompted with an information dialog in case the chosen file is invalid.  
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Figure 4-5 
Browse for and open the master *.dss file for your case 

Once a valid file has been selected, the next step is to load the circuit model as shown in Figure 
4-6. This will populate relevant circuit element data in the frames highlighted in Figure 4-6. The 
available element data can be explored by selecting an element from a given Element tab (Buses, 
Transformers, Lines, Shunts and Generators) in the top frame. The details of the chosen element 
will be updated in the bottom frame. Additionally, loading the circuit model will also load any 
previously saved progress in the harmonics tool.  

The next step in the process is to run the GIC flow analysis, as shown in  
Figure 4-7. This analysis takes place only once unless the system configuration or the 
geomagnetic disturbance-related electric field change. As a result, other analysis options become 
enabled: Frequency Scan analysis, Harmonics loop analysis, and circuit plot options. 
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Figure 4-6 
Load the master *.dss file of your case 

 
Figure 4-7 
Run the GIC flow analysis 

At this point, the circuit can be plotted and the user can explore it in the program’s graphic 
interface. As shown in Figure 4-8, beside the Plot Circuit button, a map resolution selector is 
available for the user to change the resolution of the plot (High and Normal resolutions are 
available). The capabilities of the circuit plot are detailed in the Circuit Plot capabilities 
subsection. 
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Figure 4-8 
Plot the geographic footprint of the system 

At this point, it is also possible to run a frequency scan. For this, the user must select a bus on the 
Buses tab and click on the Frequency Scan button. This function will place a current source of 1 
Ampere and will vary its frequency from the fundamental up to a user-defined higher harmonic 
order. The result is an impedance versus frequency plot as shown in Figure 4-9. The bus where 
the frequency scan analysis is performed can also be selected using the circuit plot as described 
in the Circuit Plot capabilities subsection. 

 
Figure 4-9 
Running a frequency scan at a user-selected bus 
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The most important analysis in GICharm is the harmonics loop. To run this analysis, the user 
must define a number of iterations (5 by default) and then click on the Run Iterations button as 
shown in Figure 4-10. As mentioned before, the iterations are cumulative. In other words, each 
iteration starts where the previous one ends. If progress is saved, when loading the system again, 
a dialog will ask if the user wants to start from the previously saved state of the simulation. 

 
Figure 4-10 
Running a user-defined amount of iterations of the harmonics loop 

 
Figure 4-11 
Plotting last iteration results 
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After running the harmonics loop for the first time, the program enables plots for relevant 
variables of elements in the system. As shown in Figure 4-11, at the end of each iteration of the 
harmonics loop, the user can plot waveforms and spectra of voltage and currents for capacitors, 
reactors, and generators, and of winding currents and voltages for transformers. It is also possible 
to check the evolution of the voltage magnitude for each harmonic for the GIC affected. To do 
this, the user must select an element from the desired Element tab. This will enable the plot 
options for the chosen element in the Plot last iteration section of the program interface. 

At this point, it is also possible to export *.csv files of the spectra of variables that belong to a 
user-selected element as shown in Figure 4-12. To do this, the user can right click over the name 
of the desired element in the Element tabs, and then select the Export element variables option 
from the context menu. Another option to export the variables of an element is to open the 
Export tool directly from the Tools menu. In both cases, the Export tool shown in Figure 4-12 
will appear. This tool allows the user to select all the possible elements that have exportable 
variables, and it also provides information about the user-selected element. The Export tool 
displays tables with the magnitudes and angles for the voltages and currents per harmonic order 
per phase, as well as the sequence components per harmonic order. Once the user has selected an 
element, the next step is to click on the Element button from the Export csv files section and 
select a path to save the files. 

 
Figure 4-12 
Exporting results from last harmonics loop iteration 

The results of a system level simulation depend on several variables like the core-topology of 
transformers, the GMD related electric field components, or the capacitors connected on the 
system. To check the influence of these variables, the user can modify them as shown in Figure 
4-13, Figure 4-14, and Figure 4-15. To modify the core-topologies of transformers in the system, 
the user must right click over the Transformers tab and select the option Edit core-types from the 
context menu. This will prompt the user with a Core-type editor tool that allows them to select 
the core-type of each of the transformers in the system as shown in Figure 4-13. Any change 
made in this editor will not be considered by the program unless the user clicks on the Ok button 
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and accepts to restart the harmonics loop. Additionally, the user can modify all the transformers 
at once by right clicking on the Core-type header of the editor table and selecting one of the 
available options: Reset all will reset any changes to the core-type that the user has not saved 
since the core-type editor was opened; Set all as will define all the core-types of all the 
transformers in the system as one of the four options available (3 Single-phase, 3-lib, 5-lib, 
Shell-form).  

 
Figure 4-13 
Editing the transformer core topologies 

On the other hand, to modify the connection status of capacitors and reactors in the system, the 
user must right click over the Shunts tab and select the option Edit status from the context menu. 
This will prompt the user with a Shunt status editor tool that allows them to select the connection 
status of each of the capacitors and reactors in the system as shown in Figure 4-14. Any change 
made in this editor will not be considered by the program unless the user clicks on the Ok button 
and accepts to restart the harmonics loop. Additionally, the user can modify all the status of 
shunt elements at once by right clicking on the Status header of the editor table and selecting one 
of the available options: Reset all will reset any connection status changes that the user has not 
saved since the editor was opened; Set all as will define all the status to either Connected or 
Disconnected. 

Similarly, to modify the electric field component magnitudes, the user must do a right click over 
the Electric field details section of the program interface and select the option Edit components 
from the context menu (it’s the only option in this case). This will prompt the user with a E. field 
parameters editor tool that allows them to modify the V/km value of the electric field 
components as shown in Figure 4-15. Other parameters are available for edition, but these do not 
influence the simulation in this version of GICharm. Again, any change made in the editor will 
not be considered by the program unless the user clicks on the Ok button and accepts to restart 
the harmonics loop. Additionally, the user can reset any unsaved changes by right clicking on the 
Value header of the editor table and selecting the Reset all option. 
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Figure 4-14 
Editing the status of capacitors and reactors 

 
Figure 4-15 
Editing the electric field components 

To save any progress or changes in the system, the user can click on the Save button as in Figure 
4-16, or try to close application. Every time GICharm is asked to close, the program will remind 
the user to save changes. Another option to save progress is to go to the File menu and select the 
Save option. 

0



 

4-11 

 
Figure 4-16 
Saving and loading work progress 

 
Figure 4-17 
Changing default simulation settings 

Finally, the user can reset three simulation settings with values defined by default: the maximum 
harmonic order, the maximum number of iterations to run for the harmonics loop, and the default 
number of iterations to run each time the Run Iterations button is clicked. To make these 
changes, go to the File menu, select the Harmonics loop settings option and use the dialog that 
appears to save new default values.  
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The File menu also includes options to launch OpenDSS with the currently open *.dss system 
files or launch a text editor to modify the master *.dss file (a system must be loaded in GICharm 
to enable these options). When using GICharm for the first time, it is likely that the user will be 
required to define paths for external program executables like the PDF reader, the preferred text 
editor (notepad.exe by default), or the OpenDSS executable. To do this, the user must select the 
option that corresponds in the Help menu (Reset preferred OpenDSS.exe, Reset preferred text 
editor, and Reset preferred PDF reader). The Help menu also includes the Help documents 
submenu that opens help PDF files that summarize this guide. 

Circuit Plot Capabilities 
GICharm has a number of circuit plot capabilities developed to help users in the analysis of their 
simulation results. Before starting, it is important to mention that the *.dss files used in the 
example of this section were converted from a set of *.raw and *.gic files obtained from [9]. 
Once the user has loaded a valid system and run the GIC flow analysis, the program enables the 
Plot circuit button to plot the geographic footprint of the system, along with details of relevant 
variables overlaid on top of the circuit. A map resolution selector is available with two options: 
Normal and High resolution. High resolution is intended to be used when the system spans a 
relatively small area. In that scenario, the geographic details (water bodies, rivers, state lines, 
etc.) can be enhanced with a high map resolution plot.  

The circuit plot has four plot layer options: Base plot, GIC flow directions, Fundamental voltage, 
and Voltage THD. The user can change between these layers in the Plot options selector 
highlighted in Figure 4-18. This figure also shows the Base plot which is the default option. The 
Base plot shows the voltage kV base of each line and the position of buses in the system. If the 
user hovers the mouse cursor over the lines of the system, the name of the buses connected by 
the line appear in labels at the left side of the map, and the GIC per phase flowing through the 
line is displayed beside the line and in the bottom left corner of the map.  

 
Figure 4-18 
Circuit plot - Base plot 
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The second circuit plot option is GIC flow directions which can be observed in Figure 4-19. This 
plot option allows the user to identify the lines with the highest GIC flows per phase. It uses 
arrow tips and a heatmap to identify the magnitude of GIC per phase flowing through a line. It 
can also be used, together with the Base plot, to visually identify the amount of GIC that arrives 
at a given transformer. If the user hovers over the lines of the system, the information that 
appears is similar to that of the Base plot option (bus names and GIC per phase). 

 
Figure 4-19 
GIC flow circuit plot 

 
Figure 4-20 
Fundamental voltage magnitude per phase circuit plot 
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The third circuit option is called Fundamental voltage and it corresponds to three separate 
options, one per phase. As shown in Figure 4-20, this option overlays circles on top of the system 
footprint, centered where buses, reactors, capacitors, generators or transformers are connected. 
The color and size of the circle varies with the fundamental voltage magnitude per phase. The 
heatmap that defines the color and magnitude scale is defined with the same range for all three 
phases to easily compare between phases. The default range is 0.9 p.u. to 1.1 p.u. unless the 
voltages in the system lie outside that range (this resets the range). This plot option is useful to 
identify buses where the fundamental voltage magnitude decreases considerably due to reactive 
power losses caused by the saturation of transformers during GMD events. When this plot option 
is active, if the mouse cursor is hovered over a line in the system, the line’s buses names are 
displayed and the fundamental voltage magnitudes at these buses are also displayed at the bottom 
left corner of the map.  

The fourth plot option is called voltage THD per phase, and it also corresponds to three separate 
options, one per phase. Like the third option, it also overlays circles on top of the system 
footprint centered on buses where it has reactors, capacitors, generators or transformers, as 
shown in Figure 4-21. The colors and sizes of circles vary with the voltage THD per phase. The 
heatmap that defines the color of the circles and the THD scale is defined with the same range 
for all three phases to easily compare between phases. The range is determined by the maximum 
and minimum voltage THD values found across the system over the three phases. Additionally, 
when the user selects this plot option, if the mouse cursor is hovered over a line in the system, 
the line’s buses names are displayed and the voltage THD at these buses is also displayed at the 
bottom left corner of the map. 

 
Figure 4-21 
Voltage THD per phase circuit plot 
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Figure 4-22 
Locating an element or bus on the circuit plot 

Besides the plot options, the circuit plot is also useful to explore the results of the simulation or 
the circuit itself. By going to an Element tab, doing a right click over a given element name, and 
selecting the Locate element on map option from the context menu, the user can locate most of 
the elements on the map. As a result, a label will show up on the map pointing at the bus where 
the chosen element lies, as shown in Figure 4-22. Similarly, the user can do a right click over a 
bus in the circuit plot and, from the context menu that appears, pick a bus or a circuit element 
connected to that bus. As a result, the chosen element will be selected in the corresponding 
element tab and its details will be displayed in the details frame. Figure 4-23 shows an example 
of this last capability. 

Additionally, the user can right click over the map and, depending on the active circuit plot 
option, filter or modify the order of plot objects being displayed (markers for buses, lines, and 
circles for THD and fundamental voltage). This is helpful, for example, when several buses are 
concentrated around a geographic region (a big city for instance) and their markers hide 
information making it difficult to check results. For instance, Figure 4-24 shows the THDv: 
Phase A plot and the options for this include hiding higher or lower THD bubbles, showing all 
THD bubbles, bringing bus markers to front, and bringing lines to front. 
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Figure 4-23 
Picking a bus or element from the circuit plot 

 
Figure 4-24  
Changing the order of plot objects 
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PSS/E to GICharm / OpenDSS Converter 
GICharm has a built-in converter that takes PSS/E *.raw and *.gic files as inputs and creates 
OpenDSS/GICharm models stored as *.dss files. It is important to clarify that PSS/E *.gic files 
are required for the converter to generate *.dss files for GICharm. This is since the *.raw file 
does not contain information on geographic coordinates of buses nor grounding resistance values 
for substations. GICharm makes assumptions for missing grounding resistances, but it can’t 
make assumptions for coordinates, which are required to determine GIC flows. If only PSS/E 
*.raw files are available, the converter can still generate *.dss files for an OpenDSS model to 
work directly with OpenDSS but not with GICharm. The conversion process is illustrated in the 
paragraphs. 

As it can be observed in Figure 4-25, to launch the converter, the user should go to the Tools 
menu and select the PSS/E to OpenDSS converter option. The converter window will appear at 
this point. On top of the window, the user has access to the Load PSS/E files buttons which allow 
the user to import the model input files, and the Save OpenDSS files buttons which allow the user 
to save the converted *.dss models. The successful import of a *raw file enables the button to 
save Regular files for external OpenDSS work (not usable for GICharm). It also enables the 
import of *.gic files. The successful import of a *.gic file enables the GIC harmonics tool save 
button to save *.dss files for GICharm. It also disables the save button for regular *.dss files 
because the information on the *.gic file modifies the converted model. However, the *.dss files 
for GICharm can also be loaded directly in OpenDSS.  

 
Figure 4-25 
Launching the PSS/E to GICharm / OpenDSS converter 

The converter window also includes a frame called PSS/E element description which is intended 
to display all the table records stored in both the *.raw and *.gic files. This frame is populated 
when the PSS/E files are successfully loaded. The converter window also contains an Activity 
Log which is used to display the progress of the converter during all the conversion activities 
(loading the *.raw file, loading the *.gic file, saving regular *.dss files or saving GICharm *.dss 
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files). This activity log also displays information about the number of converted elements and the 
number of disabled elements found in the input files. Additionally, the converter window also 
has a progress bar which provides feedback to the user during all the activities and routines 
performed by the converter during the process. All these window sections are intended to be used 
as tools to verify that the input files are being correctly converted to be used in GICharm or 
directly in OpenDSS.  

Once a *.raw file is loaded in the converter, the PSS/E element description frame is populated 
with tables containing the records for each device in the PSS/E model. An example of this is 
shown in Figure 4-26 for a synthetic case found at the Texas A&M University – Electric Grid 
Test Case Repository website [9, 10]. 

 
Figure 4-26 
Loading the *.raw file from PSS/E 

At this point the user can either save regular *.dss files or import a *.gic file for the already 
loaded *.raw file. Figure 4-27 shows the result of loading a *.gic file for the same synthetic case 
example found at [9]: the tables and record found in that file are also displayed in the PSS/E 
element description field. A consequence of loading the *.gic file is that some of the element 
tables are updated with new information or some fields are added in tables like 
TRANSFORMER, TRANSFORMER_3WDG and BUS (coordinate-related).  
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Figure 4-27 
Loading the *.gic file from PSS/E 

 
Figure 4-28  
Saving *.dss files for regular OpenDSS work or for GICharm 

Finally, the converted model files can be saved at a location defined by the user. Clicking the 
Save OpenDSS files buttons prompts the user with a save dialog that allows the user to define a 
path to save the converted model files. Please remember to store the files for GICharm work in a 
separate folder than those for Regular OpenDSS work. 
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